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This presentation discusses the help and documentation available with WebSphere
Message Broker Version 6.1
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Agenda

= Integrated product help

= WebSphere Message Broker information center

= Navigation

= Finding the information you want in the information center
= Printing topics

= Giving feedback

Help and documentation © 2008 IBM Corporation

These aspects of the WebSphere Message Broker product help and documentation are
covered in this presentation.
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Integrated product help: New help view
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A new Help View is provided in the Message Brokers Toolkit for version 6.1. To view the
Help view press F1 on Windows, or SHIFT + F1 on Linux, or select Dynamic Help from the
Help menu in the Message Broker toolkit.

The default view contains related topics. In the top section there is a small description of
the interface element such as a view or an object such as a node that you last selected
with the mouse. This description contains links to topics in the information center, if you
click on a link that topic will open in the Help view. You can right-click on the link to a topic
and click Open in Help Contents to open the topic in the information center (in a separate
window).

The bottom section contains relevant links from the information center, these links are
generated using a search on the values of the perspective that you are in and the name of
the interface element that you selected. The relevancy of the search results is variable
depending on the interface element selected.

When you click on a new interface element, the content of the related topics changes to
match the new object.

The upper section matches the content of infopops if you have used these in a previous
version of the toolkit.
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Help on wizards
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You can open the Help View on wizards to display related information and links. Either
click on the ? Icon on the bottom left of the wizard or press F1 on Windows, or SHIFT + F1
on Linux to display the Help view on the wizard.

When you click on links to related information in the wizard, the topic is also displayed on
the wizard. You can right-click on the link to a topic and click Open in Help Contents to
open the topic in the information center in a separate window.
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Help view contents

= Related Topics
» Infopops
» Dynamic Search

= Search
= All topics

= Bookmarked topics

= Index
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In addition to the Related Topics in the Help View, several additional options are available.
These are “Search”, “All topics”, “Bookmarked topics”, and “Index”.

The Search option provides a small text box for entering a search expression. You can
configure an advanced search expression using the normal conventions for search strings.
You can select the scope of the search to include or exclude the information center, Web
searches such as Google and IBM Developer-Works, and other help resources, such as
samples in the Samples Gallery.

The “All topics” option opens the same topic contents as the Information Center.

You can bookmark topics that you find useful, or use often to help you to find them quickly
and easily. Click on the Bookmark document button on the top right of the Help View or
Information Center page. Alternatively, you can right-click a link to a topic from a Search
that you want to bookmark and select Add Bookmark. Select Bookmarks from the options
at the bottom of the Help view to view a list of bookmarked topics.

The Index option in the Help View displays an alphabetical index of all of the
documentation in the Information center. This includes WebSphere Message Broker,
Eclipse and Rational Application Developer documentation, and any other products that
use the same Eclipse workbench, for example WebSphere Integration Developer. This is
different from the index included in the WebSphere Message Broker documentation, which
contains an index for WebSphere Message Broker only. There is a search box at the top
of the index view to make finding the index term you are looking for easier. You can type in
the first few letters to display the index starting at those letters to quickly jump to a certain
point in the index.
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Location of documentation

= Within the Message Broker Toolkit
= Local stand-alone version

= Internet version

» http://www.ibm.com/software/integration/wbimessagebroker/library/

= PDF versions
» Available from the same Web site

Help and documentation © 2008 IBM Corporation

There are several places that you can access the WebSphere Message Broker
documentation. The documentation is provided as an online information center. The
information center is available is three places; namely the Message Broker Toolkit, a local
stand-alone version, and an internet version.

The information center integrated into the Message Broker toolkit is installed automatically
when you install the Message Brokers toolkit on Windows or Linux. The Local stand-alone
version is provided on a CD or as a separate download. You can view the documentation
using this version without installing the Message Brokers Toolkit.

The Internet version is available on the web, you must have an internet connection in
order to view it. This is available at the link shown on this slide.

There are some differences between the integrated information center and the online
versions. Search is generally better in the stand-alone and internet version. The options
for printing topics and sets of topics are more advanced in these versions. However links
to other documentation in the product do not work in these versions. For example, the
links to the samples and to workbench documentation work only in the integrated
information center.

PDF versions of the documentation is available, and is discussed on the next slide.
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locumentation © 2008 IBM Corporation

This slide shows the home page of the Message Broker 6.1 product documentation. You
can reach this site from the Message Broker home page, and clicking “Library” on the left
hand navigator. Documentation for all versions is available from this page.

Clicking on the Online Information Center connects to the latest version of the
documentation available on the internet.
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PDF documents

= Introduction = Configuration,

- Quick start guide administration and security
= Managing your installation
= ESQL

= Message flows

= Diagnostic messages
= Installation guide

= Message models

o = Publish/subscribe
= Migration

= User-defined extensions = Troubleshooting

= Configuration manager API

= End-user application support programming

Help and documentation © 2008 IBM Corporation

A collection of PDF documents has been created by grouping the topics in the information
center into related subjects.

These are available for download from the same Web site as the information center.

The PDF documents are provided for convenience for printing purposes, and are not
intended as a substitute for the information center.
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Navigation toolkit version Show in Table
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less than signs) following the updated information, as shown on this paragraph. €

1f you are migrating resources from previous versions, see Migrating and upgrading.
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o Feedback
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New users: how to find the information you want
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The information center uses similar navigation to familiar Web browsers, with buttons to
navigate between pages and return to the home page. The left pane displays the table of
contents, which lists high level containers of related task-based topics. You can expand
the containers to navigate into the topics.

The topics are displayed in the right pane of the information center. You can click on links
in these topics to be taken to other related topics of interest. You can use the buttons at
the top right of the page to navigate back to previously viewed topics. You can use the
“Show in Table of Contents” button to locate the current topic in the table of contents. You
can use this to find related topics in the same area of the information center, or to find your
current location. You can print and bookmark the current topic using the buttons in this
location.

Using the buttons at the bottom left of the information center you can select what type of
information to display. This can be the contents of the information center, the full index of
all the documents in the information center, the results of the last search you performed,
links to related topics, or any bookmarked documents.

The “Refresh/Show current topic” button performs the same task as the “Show in Table of
Contents” button.

The online internet version of the Information center does not contain all of these facilities.
In particular, the Links and Bookmark facilities are not provided.

WMB61_IEA_Documentation.ppt Page 9 of 21



| IBM Software Group

Finding what you want in the information center

= Table of contents
= Search

= Index

= Glossary

= Start here topics

Help and documen © 2008 IBM Corporation

The following four slides provide information on how the information center is structured, to
help you to more easily find the topics you are looking for using the table of contents. After
these, information is provided on alternative ways to locate information.
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Task, concept and reference topics

= Concept: Introducing and explaining a concept or
subject

= Task: Numbered steps that tell you how to do
something

= Reference: Reference information for a subject,
such as a table of options

Help and documentation © 2008 IBM Corporation

The majority of topics in the information center are one of the three types, namely Task,
Concept and Reference.

The next three slides provide more information about each topic type.
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Example of a task topic

Contents o Websphere Hessage Broker Version 6.1

Creating a server project
Before you can deploy a message flow application, you must create a server project
for it.

Before you start:

Save your message flow and message set projects.

Follow these steps to create a server project using the Message Broker Toolkit.

1. Switch to the Broker Administration perspective.

2. Click File > New > Other.

.| 3. Select Show all wizards. In the list of wizards, expand Server and click
Server Project.

| 4. Click Next.

5. If you are prompted, click OK to enable "Base J2EE Support”.
6. Enter the name of your new server project.

7. Click Finish

The folder that is created appears twice in the Navigator view (if Show empty

projects in Navigators has been selected in the Broker Administration

Preferences page):
« In the Domain Connections folder

+ In the Broker Archives folder

Next:
Continue by Creating a broker archive and Adding files to a broker archive.

Related concepts
Message flow application deployment

Related reference
Broker Administration perspective

Help and documentation © 2008 IBM Corporation

Task topics contain a variety of features.

First, the pre-requisites for a task. What do you need to do before you can get started on
this task?

Second, what are the steps that you need to take to achieve the task ?

Third, the expected results. What happens when you complete the task? How do you
know it was successful?

Then, the post-requisites. Is there anything you need to do after you do this task? These
are often other tasks.

And finally, links to the relevant information. What other topics might be useful to refer to,
or are similar to this task? This itself could be a task, concept or reference.

These topics tend to be relatively short, and not to contain too much background or
reference information. In most cases, links to background information and detailed
reference information.
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Example of a concept topic
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SSL authentication

SSL authentication is available for the Real Time node, the HTTP listener, and the
WebSphere MQ Java Client.

SSL authentication for the Real Time node

SSL authentication in WebSphere Message Broker supports an authentication
protocol known as mutual ch passwort . This is a
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dard variant of the industry standard SSL protocol in which the public key
cryptography called for by SSL is replaced by symmetric secret key cryptography.
While this protocol is both secure and convenient to administer, it might be better
to use the industry standard SSL protocol exactly as defined, especially if a public
key cryptography Infrastructure is already deployed for other purposes. There are
two standardized versions of SSL which are:

Asymmetric SSL
This Is used by most Web browsers. In this protocol, only the brokers have
public/private key pairs and clients know the brokers' public keys. The SSL
protocol establishes a sacure connectian in which the broksr Ie authenticated to
the client using public key cryptography, after which the client can send its
password, encrypted by a secure session key, to authenticate itself to the broker.

@ Configurng
00 adrinsterng the broker domain
0 Developng sopicatons

0 Disgrostic messages: Ists
@ ibm.com: About 18H - Privacy - Contact

ic SSL

This s where both particlpants have pubc/private key palrs. The SSL protocol
uses public key cr

In both instances, SSL authentication does not keep the SSL protocol up for the
entire lifetime of a connection, because that would incur protection overheads on all
messages. The SSL protocol remains in force long enough to accomplish mutual
authentication and to establish a shared secret session key that can be used b
message protection (see Message protection). Messages are then individually
protected in accordance with the protection level specified for the given topic.

The SSL protocol implementation requires a Public-Key Cryptography Standards
(PKCS) file, containing X.509 V3 certificates for the broker's private key,

possibly the public kevs of clients and other brokers. This fil, called the key ring
file, must contaln at léast one certificate for the broker and for the trusted
certification authority (CA) that issued and signed the broker's certificate. For the R
form of SSL, the key ring file can also have the public keys of clients and other
brokers that need to be authenticated, and the certificates supporting those public
keys. However, the SSL protocol calls for the exchange of public keys and
certificates, so key ring files do not need to be fully primed in this fashion, as long
as there are enough commonly-trusted authorities to ensure that authentication
completes.

e

Help and documentation
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Concept topics are more text-intensive — these topics provide the background information,
and are useful to read when you are using an area of the product for the first time.
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ACL permissions

WebSphere Message Broker uses Access Control List (ACL) entries to govern which
users and groups can manipulate objects in the broker domain. There are four
different access levels that can be granted for a user or group: Full, View, Deploy,
and Edit. Not all access levels are valid for all object types. The following table
lists the ‘actions which can be performed by a user with a given permission:

Object Permission | Rights
Topology Full control

« Create and delete brokers.
 Create and delete collectives.

+ Add and remove brokers from
collectives.

« Create and delete connections.
+ Deploy topology.
« All topology View permission rights

View + View topology configuration and

managed subcomponents.

Broker Full control + Create and delete execution groups

« Edit all broker properties.

* All broker Deploy permission rights.

« All execution groups Full control
permission rights for contained
execution groups.

 All broker View permission rights.

Deploy + Deploy broker configuration.
« All broker View permission rights.

« View broker configuration and
managed subcomponents

« Implicit view access to Topology.

Execution Full control

o Edital i t
iy it all execution group properties.

« Start and stop execution groups.

WMB61_IEA_Documentation.ppt
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Reference topics can contains a lot of text and often contains lists and tables of
information such as properties or parameters. When you are performing a task it can often
be useful to refer to these topics for more detailed information. For example, if you are
unsure of why you might select certain options or use a particular value. The Reference
topics have a section in the table of contents on their own.
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Finding what you want in the information center

= Table of contents
= Search

= Index

= Glossary

= Start here topics

= Platform specifics

Help and documentation © 2008 IBM Corporation

You can locate information by using the table of contents, and navigating to the topics as described in the
previous slides. This is useful if you know what topics you are looking for, but do not know where to start
looking. There are a number facilities to help you find the information you are looking for.

You can perform a search using the help view, or within the information center by entering a search string
into the search text box. You can configure an advanced search expression using search operators in the
normal way.

For example, the asterisk character can be appended to any character string.. For example, admin* will
return information for administer, administration, and administrator.

The question mark character can be used to mean any character.
Using quotation marks means put a keyword phrase in quotes, for example "configuration manager*.

The Boolean operators AND, OR and NOT can be used to combine search arguments. For example
“mapping AND header”.

The results are displayed in the relevant order of those topics most closely matching the search criteria.
More information on how to search the Information center can be found in the WebSphere Message Broker
Information Center home topics.

An index is provided for all the topics in WebSphere Message Broker. The index is one of the last entries in
the table of contents. You can click on a letter of the alphabet to locate an item quickly.

A Glossary is provided to define WebSphere Message Broker terms and abbreviations that are used in the
information center. The glossary is shown in the table of contents. There is a migration glossary that lists
diff((ajrences in terminology between WebSphere Message Broker Version 6.1 and previous versions of the
product.

The Start here topics are a set of topics that provide links into the information center. These are available as
topics in the first container in the table of contents. These topics are designed for new users, but can be used
by anyone to get a high level description of different aspects of WebSphere Message Broker, and to link to
useful topics.

The command topics have been updated to split platform specific information into separate topics for each
command. Windows, UNIX & Linux, and z/OS have separate topics containing platform specific information
for the commands. This makes it easier to find the right parameters and settings for your platform.
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[ start here
[ product overview
[l samples
[ Migrating
[ Installing
[ security
[ configuring
[ Administering the broker domain
[ peveloping applications
[ peploying
[ pebugging
[ Troubleshooting and support
[ Uninstaling
[ reference
Bl Glossary
[ Feedback
[ ndex
[ Dizgnostic messages

Printing topics in the information center

= Stand-alone or Internet more advanced settings

=) Print this topic
Print this topic and subtopics
5 | Search this topic

Search this topic and subtopics

Help and documentation
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You can print individual topics in the Information center using the Print button, or selecting
Print from the File menu. Using the stand-alone or internet version of the Information
Center, you can now print a topic and all the sub-topics beneath it. This enables you to
print multiple related topics at the same time, rather than having to print them out one at a
time. Right-click on the container topic and select Print this topic and subtopics.

WMB61_IEA_Documentation.ppt
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Feedback link

J WebSphere Message Broker - Mozilla Firefox -{ofx|
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WebSphere Hessage Broker Version 6.1 I HEE

I Security

The topics in this section help you to deal with security in WebSphere Message Broker:
* Security overview
 Planning for security when you install WebSphere Message Broker
 Setting up broker domain securit
 Setting up 2/0S security
« Publish/subscribe security

o Securing the publish/subscribe domain

Related reference
Security requirements for administrative tasks

stic messages: fsts
S e a s o Notices | Trademarks | Downloads | Library | Supporf | Feedback

007, Al Rights Ressrved
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You can send feedback to the writers on individual topics using the Feedback button
available on all the information center topics. Click the Feedback button to display a form
that you can enter your comments into.

Feedback is logged in a database and forwarded to the author of the topic. The author
makes changes based on your comments and information from the development team.
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comments, ensure that you are viewing the latest

version of the documentation by clicking Help > Software Updates.

2. Use this form and the contacts below only to comment on the
documentation. Contact your IBM representative If you need

marketing or service help or if you have s
the functions of 18M products or systems.
have indicated that you want to comment on the following topic. Complete the

You
rest of this form to submit your comments from this page, or see below for other
ways to send us feedback.

Topic: [z

[ecury

name*:

See the ‘Fine Print’ below, before submitting your comments.

s 1 % [ & Serd st |

SIS

Help and documentation © 2008 IBM Corporation

In the feedback form, the topic number is filled in automatically.

Fill in contact details and comments and click Submit. The more information that you
include the better.

Also included on this page are alternative forms of sending feedback. These are a postal
address, a fax number, and an e-mail address, for sending attachments.

You can send more general feedback using the feedback questionnaires in the information
center. These are located under Feedback in the information center table of contents.
There is an information center specific questionnaire, and a usability questionnaire.
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Summary

= Information center
= Navigation

= Search tools

= Location

= Printing

Help and documentation © 2008 IBM Corporation

This presentation has discussed the documentation tools that are available in Message
Broker version 6.1.
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Feedback

Your feedback is valuable

You can help improve the quality of IBM Education Assistant content to better
meet your needs by providing feedback.

= Did you find this module useful?
= Did it help you solve a problem or answer a question?

= Do you have suggestions for improvements?

Click to send e-mail feedback:

mailto:iea@us.ibm.com?subject=Feedback about WMB61 |IEA Documentation.ppt

This module is also available in PDF format at: ../WMB61 IEA Documentation.pdf

Help and documentation © 2008 IBM Corporation

You can help improve the quality of IBM Education Assistant content by providing

feedback.

WMB61_IEA_Documentation.ppt
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Trademarks, copyrights, and disclaimers

gh% following terms are trademarks or registered trademarks of International Business Machines Corporation in the United States, other countries, or
oth:

WebSphere

Product data has been reviewed for accuracy as of the date of initial publication. Product data is subject to change without notice. This document
could include technical inaccuracies or typographical errors. IBM may make improvements or changes in the products or %rograms described herein at
any time without notice. Any statements regarding IBM's future direction and intent are subject to change or withdrawal without notice, and represent
goals and objectives only. References in this document to IBM products, programs, or services does not imply that IBM intends to make such products,
programs or services available in all countries in which IBM operates or does business. Any reference to an IBM Program Product in this document is
not intended to state or imply that only that program product may be used. Any functionally equivalent program, that does not infringe IBM's intellectual
property rights, may be used instead.

Information is provided "AS IS" without warranty of any kind. THE INFORMATION PROVIDED IN THIS DOCUMENT IS DISTRIBUTED "AS IS"
WITHOUT ANY WARRANTY, EITHER EXPRESS OR IMPLIED. IBM EXPRESSLY DISCLAIMS ANY WARRANTIES OF MERCHANTABILITY,
FITNESS FOR A PARTICULAR PURPOSE OR NONINFRINGEMENT. IBM shall have no responsibility to update this information. IBM products are
warranted, if at all, according to the terms and conditions of the agreements (for example, IBM Customer Agreement, Statement of Limited Warranty,
International Program License Agreement, etc.) under which they are provided. Information concerning non-IBM products was obtained from the
suppliers of those products, their published announcements or other publicly available sources. IBM has not tested those products in connection with
this publication and cannot confirm the accuracy of performance, compatibility or any other claims related to non-IBM products.

IBM makes no representations or warranties, express or implied, regarding non-IBM products and services.

The provision of the information contained herein is not intended to, and does not, grant any right or license under any IBM patents or copyrights.
Inquiries regarding patent or copyright licenses should be made, in writing, to:

IBM Director of Licensing
IBM Corporation

North Castle Drive
Armonk, NY 10504-1785
US.A.

Performance is based on measurements and projections using standard IBM benchmarks in a controlled environment. All customer examples
described are presented as illustrations of how those customers have used IBM products and the results they may have achieved. The actual
throughput or performance that anF\: user will experience will vary depending upon considerations such as the amount of multiprog}:amming in the user's
job stream, the I/O configuration, the storage configuration, and the workload processed. Therefore, no assurance can be given that an individual user
will achieve throughput or performance improvements equivalent to the ratios stated here.

© Copyright International Business Machines Corporation 2008. All rights reserved.

Note to U.S. Government Users - Documentation related to restricted rights-Use, duplication or disclosure is subject to restrictions set forth in GSA
ADP Schedule Contract and IBM Corp.
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